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1. GETTING STARTED 

Product Overview 

This section provides an overview of the Tampa Microwave Carrier Monitor System 
(Models VC1800 and VC3500) and connecting details.  The Carrier Monitor System 
comprises of a spectrum analyzer, I/Q signal processor, communications processor, and 
software all contained in a single 1RU chassis.  Combined, these elements produce a 
powerful tool for monitoring the RF signal components of a satellite communications 
network. 

Based on configuration data provided by the customer, the system periodically samples 
the RF signal at each carrier frequency and determines the carrier center frequency, 
bandwidth, power, CNR, etc.  The system then compares the sample results to acceptable 
limits configured by the customer, and generates an alarm if the limits are exceeded. 

NOTE: Must establish hardware connections before you can start Spectrum 
Analyzer Control Panel. 

Supplied Accessories 
� � �

Power Supply 

  AC Power Cord 

  Operating Manual 

  Spectrum Analyzer Control Panel (SACP) Installation CD 

Carrier Monitor System (Models VC1800 or VC3500)��

�

�

�

�

�
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Instrument Overview 
    

Rear Panel Display 

 

1 RF Inputs 1-8*  

2 Parallel Port  

3 VGA 

4 USB 2.0 

5 Ethernet 10/100 

6 Chassis Ground 

7 Power Supply 
Connects 

8 Reference In/Out 

*Some models may only 
have one input.

 
Front Panel Display 

 
9 On/Off Switch 

10 System Status 

11 Input Indicator 
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Connecting to the Carrier Monitor  
1. Connect PC Monitor to VGA Port. 
2. Connect Mouse and Keyboard to USB ports. 
3. Connect Power Supply to Carrier Monitor System Power Supply. 
4. Turn on Power Switch. 

a. System light should be on (refer to #10 under front panel display). 
b. Wait for Windows XP to boot into log in screen. 
c. At log in screen, type in User Name and Password below: 

 
  User Name:   Administrator  

Password:  Morrow 
 

NOTE:  Monitor, mouse and keyboard are not included 
 
*Go to the next section to Create a Trace Using Spectrum Analyzer Control Panel (SACP) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
�

�

�
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2. CREATING A TRACE USING 
SPECTRUM ANALYZER 
CONTROL PANEL (SACP) 

Use the following steps to start SACP and create a 
trace.  

1. From the desktop, double click the icon to start SACP. The main Front Panel 
window is displayed.  

2. From the tool bar, select Instrument click Connect.  
 

 
 

3. The Add Trace dialog box is displayed.  
 

1. Type in Host Name OR uncheck box and enter IP Address when connecting from 
remote PC.  
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2. Click Local button when connecting inside the operating device. 
 

 

 
3. Click OK on the Add Trace dialog box. 

 
4. Highlight trace(s) to display and click Add Selected.   

 

 
 
 

5. The trace is then displayed on the Trace Display panel.  
 

Instrument Host 
Name/IP Address 
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Using Instrument Menu  

By default, instrument is in Monitor Mode, which means Carrier Monitor has control of 
SACP.  To change to Control mode, click Instrument>TCP Connection>Control. 

NOTE: When selecting between Monitor and Control modes, it will display a lower case 
“a” when in Monitor mode, and capital “A” when in Control mode located in the 
trace legend.  

Control Mode in Trace Legend 

 

Monitor Mode in Trace Legend 
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Instrument Menu Display 

�

1. From the menu you can: 

· Choose Disconnect to disconnect from instrument. 

· Choose Monitor/Control  to allow or enable user control of instrument when 
carrier monitor is running. 

· Choose Reference to switch between external or internal reference. 

 

· Choose Manage Traces to:�

��� Add trace, Rename trace or Remove trace�

�

a. Add trace by typing in trace name and click OK. 
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�

Display of added trace created 

�

b. From this menu you can Add another trace, Rename an active 
trace(s) or Remove active trace(s).  Click Done when you are 
finished. 

· Choose Properties to create a user name and password to save instrument. 

�

NOTE: An instrument restricted user can use the Instrument Properties to enter an 
assigned user name and password, and make changes to, then save an Instrument 
Configuration.  

�
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3. INSTALLING SPECTRUM 
ANALYZER CONTROL PANEL 
SOFTWARE ON REMOTE PC  

Tampa Microwave introduces the Spectrum Analyzer Control Panel software for our 
VigilCom® Spectrum Analyzers. The following instructions are used to install your 
Spectrum Analyzer Control Panel Software.  

How to Install SA Control Panel Software  

Follow these instructions to install your Spectrum Analyzer Control Panel software.  
 

1. Remove all older versions of Spectrum Analyzer software from your system by  
clicking Start > Control Panel > Add or Remove Programs.  

 
NOTE:   These installation instructions apply to Windows XP systems. Consult your 

Microsoft® documentation for other operating systems. 
  

2. Quit all Windows Programs.  
3. Place the installation CD in your CD drive.  
4. Click Start > My Computer and then double click the Compact Disc directory.  
5. Double click the sacp_setup icon.  

 
The Installation Wizard launches immediately followed by the Welcome screen.  

 
Welcome Dialog Box 
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6. If you have already quit all Windows programs, click Next. The Choose Destination 
Location screen displays.  
 

NOTE:   If you have not quit all Windows programs, click Cancel and please do so before 
proceeding with the installation.  

Choose Destination Location 

 

 
7. If you want to change the Destination Folder, you can click Browse to locate  

another directory, or click Next to install the program in the default directory 
C:\Program Files\Spectrum Analyzer. The Select Components screen displays.  
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Component Options  

The Component options, User and Network Interface are selected by default. Spectrum 
Analyzer Control Panel must have both components activated to run. During installation, 
ensure these check boxes remain checked for your system to run correctly.  

The Tools check box is an optional selection, but recommended if you are responsible for 
configuring instrument options. Tools are instrument configuration utilities used for 
diagnosing and configuring an instrument. 

 

Component  Description        

User Interface Software used to display Spectrum Analysis results on your PC 

Network Interface Support for communication with any VigilCom® Model Spectrum 
Analyzer (ie. VC1800 and VC3500) 

Tools Miscellaneous tools for diagnosing and configuring the instrument.  
Tools is an option selection, but recommended if you are 
responsible for configuring instrument options.   
  

Select Components 

 

 
1. Click Next. The Select Program Manager Group screen displays.  
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Select Program Manager Group 

 

 
2.  The default group is Tampa Microwave, which appears in the Programs Menu. When you  
      click Start > All Programs > Tampa Microwave > Spectrum Analyzer Control Panel the    
      program launches. Keep this default unless you absolutely must change your Program  
      Manager Group.  

 
3.  Click Next. The Start Installation screen displays.  

Start Installation 
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4.   Click Next to begin the installation. When the install is finished, the Installation  

Complete screen displays.  

Installation Complete 

 

 
5.  Click Finish. The final Install screen displays.  

Final Install Dialog Box 

 

The final Install screen notifies you of the restart command. Click OK to restart your 
PC immediately. You can click Cancel and restart your system later. However, you 
must restart your system for the Spectrum Analyzer Control Panel software to run.  
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Removing SA Control Panel Software  

To remove SA Control Panel from your PC,  
 
1. Close SA Control Panel by selecting File > Exit, or clicking the Close button in the 

right corner of the title bar.  
2. From the Start Menu, select Control Panel. The Control Panel displays.  
3. Click the Add or Remove Programs button.  
4. Scroll through the “currently installed programs:” list box until SA Control Panel is 

highlighted.  
5. Click the Change/Remove button.  
6. Follow the on-screen prompts.  

 
NOTE:   These instructions apply to the Windows XP operating system. Other Windows operating 

systems may use different options to remove programs.  
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4. CONNECTING TO CARRIER MONITOR 
VIA TCP/IP 

Creating an IP Address  

 
This section is designed to help you accurately establish your own IP address on your 
VigilCom® Spectrum Analyzer. First, work through the steps using Tampa Microwave's 
default IP addresses, then follow the instructions to establish your own IP address.  
 

NOTE:  IP Address is an advanced feature. It is strongly recommended you contact your 
IT administrator to assist you with this process.  

 
By setting up an IP address, you are establishing communication between a PC and the 
VigilCom® Spectrum Analyzer.  

 
You need to:  
 
1. Set up a networking connection for the PC using Start > Network Connections.  

 
NOTE:  Contact your IT administrator to assist you with this task. When setting up the 

networking connection for the PC or laptop, you must assign the following Tampa 
Microwave default address: 192.168.9.2. 

  
2. Install the SACP software on the PC.  (For more information, please refer to Section 3:     
    Installing SACP Software on Remote PC).  
 
3. Establish the hardware connection between the PC and the Spectrum Analyzer.  
 
4. Verify the connection between the PC and the Spectrum Analyzer.  

Establishing a Connection with Spectrum Analyzer  
 

Once the network connection for the PC is established and the SACP software installed, 
you can use the following steps to establish a connection between the PC and VigilCom 
unit.  

 
Your VigilCom® Carrier Monitor ships with the default IP address, 192.168.9.1. You can 
use this default address to establish an interim connection, and then assign your own IP 
address at a later time.  
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1. From the Start menu, click Run.  
 

 

 
2. The Run dialog box is displayed. Type cmd in the Open field.  

 

 

 
3. Click OK. The command line dialog box is displayed.  

 

 

 
4.  From C:\, type ping 192.168.9.1 and press the Enter key. A reply message is  
displayed.  
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NOTE: An OS firewall can prevent the ping procedure from running. You can ensure 
connectivity between your PC and the Spectrum Analyzer by using Remote 
Desktop Connection.  You can successfully connect through remote PC using 
SACP and entering the default IP Address 192.168.9.1 

Establishing Your Own Fixed IP Address with Remote 
Desktop Connection  

To establish your own fixed IP address, first launch the Remote Desktop Connection 
Utility. For PCs running Windows XP, the Remote Desktop Connection utility is 
preinstalled. For PCs running Windows 2000, you can obtain the Remote Desktop 
Connection Utility by downloading it from the Microsoft Web site.  

 
Once you confirm:  

 
· The SACP software is properly installed,  
· A PC to PC connection is established between the PC and Spectrum Analyzer,  
· The Spectrum Analyzer is displaying a trace on the Trace Display panel,  

 
You can then follow these steps to set up your own fixed IP address.  

 
1. From the Start menu, click Start > Programs > Accessories > Communications > 

Remote Desktop Connection.  
 

2. From the Remote Desktop Connection dialog box, enter the Spectrum Analyzer's 
default address, 192.168.9.1. Click the Connect button. 

 



VigilCom® User’s Manual  Version 2.0 �� ������� �
 

 

 
3. The Log On to Windows dialog box is displayed. You are now connected to the Windows XP 

operating system residing on the Spectrum Analyzer.  
 

4. In the User Name field, type Administrator . In the Password field, type Morrow .  
 
NOTE:   The User Name and Password fields are case-sensitive. Type the user name and password as 

shown above.  
 

5. From the Start menu, click Start > Settings > Network Connection. The Network 
Connections dialog box is displayed.  

 
6. From the Network Connections dialog box, double click the Local Area Connections icon. 

The Local Area Connection Status dialog box is displayed.  
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7. Click the Properties button. The LAN Properties dialog box is displayed.  
 

 

 
8. Highlight the Internet Protocol (TCP/IP) item, then click the Properties button. The Internet 

Protocol (TCP/IP) Properties dialog box is displayed.  
 

9. Click Use the Following IP Address. In the IP Address field, type the fixed IP address, then 
click OK.  
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10. Close all dialog boxes by clicking OK or the Close button.  

 

This completes the instructions for establishing a fixed IP address. It is important to remember 
your fixed IP address resides in the Spectrum Analyzer's XP operating system. Please make a 
note of your fixed IP address for future use. 
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5. ABOUT SA CONTROL PANEL  

Tour of the SA Control Panel Interface  
 

When you start the interface for the first time, the Spectrum Analyzer Control Panel 
is displayed on your desktop, with a blank Instrument Configuration shown in the 
workspace.  
 
   Blank Instrument Configuration Display 
 

 
 

Once you open SA Control Panel, and start the user interface, you click Instrument 
> Connect, then enter a Host Name or IP Address to access a trace. When the trace 
displays on the Instrument Configuration, you set the parameters you want and then 
save the Instrument Configuration to your hard disk, or the desktop, for use at a later 
time, or at other workstations. You can display, hide, minimize, or move most 
toolbars around on the screen as needed. The following graphic illustrates the main 
workspace for SA Control Panel with an Instrument Configuration shown. This 
illustration provides a mini map of the most frequently used functions in SA Control 
Panel. The remaining sections of this chapter provide information about SA Control 
Panel features. Subsequent chapters provide information on the use of these features.  
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Spectrum Analyzer Control Panel with Active Instrument Configuration 

 

About the SA Control Panel Features  
 

Toolbar  

The Toolbar displays buttons that when pressed, provide one click access to many of the same 
functions used on Menus. Click any toolbar button to activate its function. Buttons displayed in 
light gray are disabled.  

Toolbar 

 

 
 
 
 
 
 
 
 



VigilCom® User’s Manual  Version 2.0 �� ������
 �
 

Marker Bar  

The Marker Bar buttons provide one-click access to many of the same functions used on 
the Marker Menu. Click any marker bar button to activate its function. Buttons displayed 
in light gray are disabled. For more information, see “Working with Markers” on page 
52.  

 

Marker Bar 

 

Trace Legend  
 

With the Trace Legend, you can view or choose multiple traces displayed in the list box. 

For example, from the Toolbar, click the Add Trace button .   The Add Trace-Select 
Instrument dialog box is displayed. Type the Host Name of the instrument you want to 
connect to, then click OK.  

Another trace is added below the first trace on the legend, and displays various 
instrument settings. You can highlight to choose any trace in the legend with one click. 
Click Trace > Properties to change the color of additional traces, and make them easier 
to recognize. You can also change the width and style of the trace using Trace > 

Properties. Delete traces by clicking the Remove Trace button . 

Trace Legend 

 

Menu Bar  

The Menu Bar displays when you first open SA Control Panel. The Menu Bar contains many 
menus typically used for standard Windows functions, and Spectrum Analysis. For more 
information, see “Common Menus” on page 66, then refer to “Using the Trace Menu” on page 41 
or “Working with Markers” on page 52 for details on the Trace and Marker menus.  

Menu Bar 
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Set Parameters Option Buttons  
 

Once an Untitled Instrument Configuration is displayed on the workspace, you can 
use the Parameters Option Buttons to change settings. The Set Parameters Option 
Buttons are used to set the Input, Span, Center Frequency, RBW, VBW, and dBm.  

 

Instrument Configuration displayed on the workspace 

 

Input  
 

Choose Input if your server is configured for multiple inputs. When you 
click the Input button, the Input Menu is displayed with the names of 
inputs available for the instrument.  

 
Span  

When you click the Span button, the Span keypad is displayed on the 
workspace. Use this keypad to set your Span parameters.  

NOTE: When you hover your mouse over any Parameters Option button, the up and down 
arrows display. After you type a setting, use these buttons to increase or decrease 
the setting incrementally. 
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Span Button with Span keypad 

 

Center Frequency  

When you click the Center Frequency button, the Center Frequency keypad is 
displayed on the workspace. Use this keypad to set your Center Frequency.  

Center Frequency Button with Center Frequency keypad 
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RBW  

When you click the RBW button, the RBW keypad is displayed on the 
workspace. Use this keypad to set your Resolution Bandwidth Filter.  

RBW Button with RBW keypad 

 

VBW  

When you click the VBW button, the VBW keypad is displayed on the 
workspace. Use this keypad to set your Video Bandwidth Filter.  

VBW Button with VBW keypad 
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Reference Level (dBm)  

When you click the dBm button, the Set Reference Level keypad is displayed on 
the workspace. Use this keypad to set your Reference Level. 

dBm Button with Set Reference Level keypad 
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6. INSTRUMENT 
CONFIGURATION  

Preparing Instrument Configuration  

With Spectrum Analyzer Control Panel, you can create a variety of Instrument 
Configurations, save them as .sac files, then open and view Instrument Configurations at 
a later time, or from other workstations.  

 
An Instrument Configuration contains a specific set of parameters, which can be saved 
for a variety of purposes. For example:  

 
· You can open and view an Instrument Configuration on another workstation.  

· You can print an Instrument Configuration to hard copy.  

· You can send an Instrument Configuration via email.  

Understanding Instrument Configuration  
 

An Instrument Configuration includes the Plot Window, the Parameters Option 
Buttons Area, and the Trace Legend. All spectrum sweeps are traced on the Plot 
Window. The Parameters Option Buttons Area displays current instrument 
settings, and reflects changes to those settings when made. The Trace Legend 
displays a list box of information on a single trace or multiple traces.  

When an Instrument Configuration is displayed, you access data from settings 
made during the initial setup process. You can make changes to settings as needed 
using the Parameters Option Buttons. 

Examine the screen shots of the Spectrum Analyzer Control Panel user interface 
below, then follow the instructions to create and save an Instrument 
Configuration.  

Saving Instrument Configuration  

Once you set parameters and an active trace displays, you have an Untitled Instrument 
Configuration file (.sac) you can save. Follow the instructions below to save an 
Instrument Configuration.  

 

1. From the Toolbar, click the Save As button .  The Save As dialog box is 
displayed.  
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Save As dialog box 

 

2. In the File Name field, type a name for the instrument configuration, for example, 
Remote Site One.sac. Select a folder.  

3. Click Save. The Instrument Configuration is saved to My Documents.  
 

Saving to the Desktop  
 

You can save an Instrument Configuration to the desktop for operators and others 
to use. Follow these instructions to save an IC to the desktop.  

 
1. Create an Instrument Configuration.  

2.  From the Toolbar, click the Save As button . The Save As dialog box is 
displayed. 

Save As to the Desktop 
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3. From the Save In area, click the down arrow and choose Desktop. The Save 
As dialog box is displayed.  

Save As dialog box 

 

4. In the File Name field, type a name for the instrument configuration, for 
example, Remote Site One.sac  

5. Click Save. The Instrument Configuration is saved to the desktop.  
 
NOTE:  You can also save .sac files to My Documents, create shortcuts for each, then drag 

and drop them to the desktop for operator use.  
�

Set Protection  

Set Protection is used to add security to an Instrument Configuration. With Set 
Protection, you can open an Instrument Configuration, choose File > Set 
Protection enter a document password, then change permissions to gain access to 
the Spectrum Analyzer. 
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Set Document Protection 

 

Adding Additional Traces  

You can add additional traces to an Instrument Configuration. When you add a new trace 
to an active Instrument Configuration, the Select Instrument dialog box is displayed. You 
can change the Trace Color. For viewing ease and trace distinction, it is recommended 
that you change the color of each additional trace. You can also set display properties by 
selecting options from the Trace Type area of the Trace Menu. Follow the instructions 
below to add another trace to an active Instrument Configuration and change display 
properties.  
 

1. From the Toolbar, click the Add Trace button . The Select Instrument dialog box 
is displayed.  

 

NOTE:  From the Trace Menu, you can also choose Trace > Add to display the Select 
Instrument dialog box.  
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Add Trace - Select Instrument 

 

 
2. Type your Host Name in the field. Click OK. An additional trace is added to the 

Instrument Configuration.  

3. From the Trace Legend, click the new trace. The active trace displays the letter “A” 
on the left.  

Trace Legend with multiple traces 
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Changing Trace Color  
 

1. From the Trace Menu, click Trace > Properties. The Trace Properties dialog box is 
displayed.  

 
 
 
 
 
 
 

Trace > Properties 

 

 

2. From the Trace Properties dialog box > Line Style tab, click the Change 
button. The Basic Color box is displayed.  

Basic Color Box 
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3. Click a new color from the Basic colors area, or create your own Custom 
Color by clicking Define Custom Colors. Click OK. The trace displays with 
the new color on the Trace Legend, and the Plot Window.  

4. You can change the Width and Style of the new trace from the Properties 
dialog box. Click the drop down arrow to choose a different width or style.  
 
 

Multiple Traces on an Instrument Configuration 
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Selecting Trace Type  

There are seven options available in the Trace Type section of the Trace Menu. You 
make your selection based on the data you want to receive on each trace.  

Trace Type segment of Trace Menu 

 

Choose from the Menu:  
 
· Normal - This is the default setting, and displays the actual trace value data.  

· Max Hold - Tracks and displays the maximum data value at each frequency.  

· Min Hold - Tracks and displays the minimum data value at each frequency.  

· Average - Tracks and displays an average of the amplitude at each frequency.  

· Marker 1 VDiff, or Marker 2 VDiff - Tracks and displays a signal buried in noise, 
or locates a signal under a signal.  

· Clear - Temporarily removes Max Hold and Min Hold on a trace for one sweep. 
Thereafter, Max and Min Holds resume.  
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Using the Trace Menu  

You use the Trace Menu for a variety of functions. When you click Trace, the menu 
displays the following options. This brief “How To” list is followed by a detailed section 
on each option. 

Trace Menu 

 

· The item(s) listed first is the Host Name of the instrument you are connected 
to. Other host names display in this section when created.  

· Choose Frequency to display the secondary menu(s) and make adjustments 
for this setting.  

· Choose Amplitude to display the secondary menu(s) and make adjustments 
for this setting.  

· Choose RBW Filter to display the secondary menu(s) and make adjustments 
for this setting.  

· Choose VBW Filter  to display the secondary menu(s) and make adjustments 
for this setting. 
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· Choose Input  to display the secondary menu to chose input 1 through 8. 

· Choose Advanced to display the secondary menu(s) and make adjustments 
for Sweep Mode, Stepping, and Return Data.  

· Choose Add to add a new trace on an Instrument Configuration.  

· Choose Add Max Hold  to  Add to this Section 

· Choose Add Min Hold  to 

· Choose Add Average to 

· Choose Load to locate and load saved traces on an Instrument Configuration.  

· Choose Save to save traces, and then load them on an Instrument 
Configuration.  

· Choose Remove to delete traces from an Instrument Configuration.  
 
NOTE:  For information about the Trace Type segment, see “Selecting Trace Type” on 

page 40.  
 

· Choose Hold or Hold All  to suspend the trace(s).  

· Choose Release All to continue trace activity using the current trace data.  

· Choose Properties to display the Properties dialog box. From the Line Style 
tab, you can change the Color, Width, or Style of the current trace.  

 
 

Setting Sweep Parameters  
 

Setting Center Frequency, Start/Stop Frequency, and  Span  
 

From the Trace > Center Frequency flyout menu, you can set frequency parameters. 
Follow these instructions to accomplish this task. 
 

Trace Menu > Frequency flyout menu 
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1. From the Trace Menu, click Frequency > Center Frequency to view the action 
menu.  

2. Click Decrease to lower the Center Frequency, or click Increase to set the Center 
Frequency higher. The frequency decreases or increases based on the Set Step 
number. (See #4).  

3. Click Set to start the Set Center Frequency dialog box, then enter the frequency you 
want to view, and click the appropriate unit button.  
 

Set Center Frequency dialog box 
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4. Click Set Step to start the Set Step dialog box, then enter the incremental number you want 
the center frequency to move when pressing the increase/decrease arrows next to the Center 
Frequency option button.  

Set Step Frequency and Span dialog box 

 

NOTE:   Start Frequency, Stop Frequency, and Span have the same commands as Center 
Frequency. Follow steps 1-4 above to change these menu items. From Display Mode, 
you can choose Center/Span, or Start/Stop view.  
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Setting Amplitude (dBm)  

From the Trace > Amplitude flyout menu, you can set amplitude parameters. Follow 
these instructions to accomplish this task. 

Trace Menu > Amplitude flyout menu 

 

1. From the Trace Menu, click Amplitude to view the action menu.  

2. Click Down to decrease the amplitude, or click Up to increase the amplitude. The 
amplitude decreases or increases based on the Set Step number. (See #4).  

3. Click Set to start the Set Reference Level dialog box, then enter the frequency you want 
to view, and click the appropriate unit button.  

Set Reference Level dialog box 

 

4. Click Set Step to start the Set Step dialog box, then enter the incremental number 
you want the reference level to move when pressing the increase/decrease arrows 
on the Amplitude option button.  

Set Step Reference Level dialog box 
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Setting RBW/VBW Filter  

RBW 

From the Trace > RBW/VBW Filter flyout menu, you can set RBW/VBW Filter 
parameters. Follow these instructions to accomplish this task. 

Trace Menu > RBW Filter flyout menu 

 

 

 

 

Trace Menu > VBW Filter flyout menu 
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1. From the Trace Menu, click RBW/VBW Filter to view the action menu. Auto 

holds the RBW/VBW filter at the center frequency by default. After 
increasing or decreasing, click Auto to return the RBW/VBW filter back to 
the center frequency.  

2. When in Auto, RBW/VBW  is set to a ratio of 0.66667.  To change this ratio, 
click Trace>VBW Filter >Set Ratio. 

NOTE: Limit on setting RBW/VBW ratio is  

3. Click Decrease to lower the RBW/VBW Filter, or click Increase to set the 
RBW/VBW Filter higher. The frequency decreases or increases based on the 
Set Step number. (See #5).  

4. Click Set to start the Set RBW/VBW Filter dialog box, then enter the 
frequency you want to filter, and click the appropriate unit button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Set RBW/VBW Filter dialog box 
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5. Click Set Step to start the Set Step dialog box, then enter the incremental 
number you want the RBW/VBW Filter to move when pressing the 
increase/decrease arrows on the Amplitude option button.  

Set Step RBW/VBW Filter dialog box 

 

�

 

Handling Traces 
 

Adding a Trace  
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You can add a trace to the active Instrument Configuration using the Trace Menu. 
Follow these instructions to add a trace.  

 
1. From the Trace Menu, choose Add.  

2. The Add Trace to View dialog box is displayed. 
 

Add Trace To View – Add selected Trace 

 

3. Highlight the trace to display and click Add Selected 
 

Instrument Configuration with active traces 

 

Loading Saved Traces  
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You can insert saved trace files (.trc) on an active Instrument Configuration using 
the Trace Menu. Follow these instructions to load saved traces.  

 
1. From the Trace Menu, choose Load.  

2. The Load Trace Data From dialog box displays.  

The Load Trace Data From dialog box 

 

3. Select a saved trace (.trc files) from your directory.  

4. Click Open. The loaded trace remains fixed, while the active trace continues 
scanning. The saved trace file and settings appear on the Trace Legend section 
at the bottom of the Instrument Configuration. Saved traces are obtained by 
using Trace > Save As. For more information, see “Saving Traces.”  

 
Saving Traces  

 
You can create a trace file (.trc) and save it in a directory of your choice. Follow 
these instructions to create and save traces.  

 
1. From the Trace Menu, choose Save.  

2. The Save As dialog box displays.  
 
 
 
 
 
 
 

The Save As dialog box 
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3. Navigate to a directory of your choice.  

4. In the File Name field, name the file and add a .trc extension.  

5. Click Save to save the file.  
 

To load a trace on an active Instrument Configuration, use Trace > Load. For 
more information, see “Loading Saved Traces.”  

 
Removing Traces  

 
You can remove a trace from an Instrument Configuration using the Trace Legend 
or Trace Menu. To remove a trace:  

 
1. From the trace legend, click the trace you want to remove. The active trace 

displays the letter “A” on the left.  

2. From the Trace Menu, choose Remove.  

3. The trace is cleared from the trace display panel.  
 

Hold/Release  
 

You can use Hold to hold a trace in a current state on an Instrument 
Configuration. All other traces continuously update while the spectrum analyzer 
is sweeping, but the held trace remains unchanged until you choose Release from 
the Trace Menu. Follow these instructions to use Hold/Release.  

 
1. From the Trace Legend, click to highlight the trace you want to hold.  

Trace Legend with Multiple Traces 
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2. From the Trace Menu, choose Hold. The highlighted trace freezes on the Instrument 

Configuration, and Hold changes to Release on the Trace menu.  

3. To continue a trace, choose Release from the Trace Menu.  
 

Hold All/Release All  
 

You can use Hold All/Release All to freeze one or more traces simultaneously on a Trace 
Display Panel. Follow these instructions to use Hold All/Release All.  

 
1. From the Trace Menu, choose Hold All . The trace(s) freezes on the Trace Display 

Panel.  

2. To continue the sweep of a trace(s), choose Release All from the Trace Menu.  
 

To continue, see “Working with Markers” on the next page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. WORKING WITH MARKERS  

Activating a Point Marker  

Point Markers affect the active Instrument Configuration on top of the workspace. 
Use the Marker Bar for one click access to Point Markers A or B. You can click the 
Switch button to activate the Marker Bar. Point Marker A is V shaped on an 
Instrument Configuration. Point Marker B is O shaped on an Instrument 
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Configuration. Follow these instructions to activate a Point Marker from the Marker 
or Menu Bar.  

From the Marker Bar  

From the Marker Bar, you can attach a Point Marker using the Switch button. Follow 
these instructions to accomplish this task.  

Marker Bar 

 

 
1. From the Marker Bar, click the Switch button. The Marker Menu displays.  

Switch button and Marker Menu 

 

 
2. Choose Marker A or Marker B .  

3. A peak Marker displays on the Instrument Configuration, and the  

button or button is highlighted on the Marker Bar.  
 
 

From the Menu Bar  
1. Click Marker on the Menu Bar. The Marker Menu displays. 

 
Marker Menu 
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2. Point to Marker A or Marker B . The Marker secondary menu displays to the 
right.  

Marker Secondary Menu 

 

3. Click Show. Once clicked, Show toggles to Hide activating functions on this 
menu.  

Marker Menu with functions activated 

 

NOTE:  All dimmed options are disabled menu and option bar items available in a future 
release of the software. 

4. A peak Marker displays on the Instrument Configuration.  
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Peak Marker A or B 

 

NOTE:  You can remove a point marker by choosing Point Marker A or B again from the 
Switch > Marker Menu.  

Activating a Line Marker  

Line Markers affect the active Instrument Configuration on top of the workspace. Use the 
Marker Bar for one click access to Line Markers 1 or 2. You can click the Switch button 
to activate the Marker Bar. Line Marker 1 is a solid horizontal line on an Instrument 
Configuration. Line Marker 2 is a dashed line on an Instrument Configuration. Follow 
these instructions to activate a Line Marker.  

From the Marker Bar  
You can attach a Line Marker using the Marker Bar. Follow these instructions to 
accomplish this task.  

 
1. From the Marker Bar, click the Switch button. The Marker Menu displays.  

Switch and Marker Menu 

 

 

2. Choose Marker 1 or Marker 2 , and the button, or the button is 
highlighted on the Marker Bar.  

 
3. A solid horizontal line displays on the Instrument Configuration when you 

choose Line Marker 1 . A dashed horizontal line displays when you choose 
Line Marker 2 .  

 
Line Marker 1 or 2 
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NOTE:   You can remove a line marker by choosing Line Marker 1 or 2 again from the Switch 
> Marker Menu.  

From the Menu Bar  
1. Click Marker on the Menu Bar. The Marker Menu displays.  

Marker Menu 

 

2. Point to Marker 1 or Marker 2 . The Marker secondary Menu displays to the right.  

Marker Secondary Menu 

 

 
3. Click Show. Once clicked, Show toggles to Hide activating functions on this 

menu.  

Marker Menu with functions activated 
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NOTE:  All dimmed options are disabled menu and option bar items available in a future 
release of the software. 

4. A Line Marker displays on the Instrument Configuration.  

Line Marker 1 or 2 

 

NOTE:   You can remove a line marker by choosing Line Marker 1 or 2 again from the 
Switch > Marker Menu.  

Managing Point and Line Markers  

There are several ways you can manage Markers on an Instrument Configuration.  
 
You can:  
 
· Drag and Drop the Marker(s) directly on the Instrument Configuration.  

· Use the Marker Bar.  

· Use the Menu Bar.  
 

Drag and Drop For Point or Line Markers  
1. Click the Point or Line Marker with the left mouse button.  

2. Hold the left mouse button down and drag the Marker to the appropriate peak.  
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3. Release the mouse button, and the Marker anchors to the appropriate peak.  
 

Use the Marker Bar  

After activating a Point Marker you must press the or button to start other 
functions on the Marker Bar.  

From the Marker Bar you can click the: 

· button to move a Marker left to the next peak. 

· button to move a Marker to the highest level in a sweep.  

·  button to move a Marker to the next highest peak.  

·  button to move a Marker right to the next peak.  

· button to set the reference level to the Marker amplitude.  

· button to set center frequency to the Marker frequency. 

· button to set the instrument to follow a signal.  Follow automatically maintains the 
Marker on a moving peak.  

· button to move Point Markers 3 dB lower than the current peak.  

· button to move Point Markers 6 dB lower than the current peak.  

· button to move Point Markers 60 dB lower than the current peak.  

· button to activate Marker Noise Mode. By using Marker Noise the Marker readout is 
normalized to a 1 dB bandwidth, specifically units of dBm/Hz. An “N” displays at the 
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bottom of the Instrument Configuration indicating Marker Noise Mode is activated for 
Marker A or B.  

Use the Menu Bar  

From the Menu Bar point to Marker > Marker A or B.  

The secondary menu displays and you can:  

Marker - Full Menu 

 

· Start Markers by choosing Show  
· Stop Markers by choosing Hide.  
· Move a Marker to the highest level in a sweep by choosing Peak.  
· Move a Marker to the next highest peak by choosing Next Peak.  
· Move a Marker left to the next peak by choosing Peak Left.  
· Move a Marker right to the next peak by choosing Peak Right.  
· Set the instrument to follow a signal by choosing Follow Peak.  
· Make the center frequency equal to a Point Marker frequency by choosing Set 

Center Frequency.  
· Set the reference level to the Marker amplitude by choosing Set Reference 

Level.  
· Choose Noise start noise suppression. By using Marker Noise the Marker 

readout is normalized to a 1 dB bandwidth, specifically units of dBm/Hz.  

Use the Marker Bar for Line Markers  

After activating a Line Marker, you must press the or button to start other 
functions on the Marker Bar. From the Marker Bar you can click the:  

· button to move a Marker left to the next peak.  
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· button to move a Marker to the highest level in a sweep.  

· button to move a Marker to the next highest peak.  

· button to move a Marker right to the next peak.  

Use the Menu Bar for Line Markers  

From the Line Marker Menu Bar you can:  

Line Markers Full Menu 

 

· Stop Makers by choosing Hide  
· Move a Marker to the highest level in a sweep by choosing Peak  
· Move a Marker to the next highest peak by choosing Next Peak  
· Move a Marker left to the next peak by choosing Peak Left  
· Move a Marker right to the next peak by choosing Peak Right  
· Set the instrument to follow a signal by choosing Follow Peak.   
· Set the reference level to the Marker amplitude by choosing Set Reference 

Level.  
· Choose Enable Alarm to cancel alarm 
· Choose Alarm >Upper/Lower Limit  to set Marker 1 or Marker 2 upper or 

lower limit alarm indicators. 

Activating a Mask 

Mask files contain data points you use to constrain areas on a trace you want to 
examine.  You create the upper and lower mask files using a text editor.  With these 
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files you can mask each Carriers exact shape.  Alarms are activated based on the 
mask shape. 

Creating Mask Files 

1. Click Start>Programs>Accessories>Notepad 

2. The following example represents information used to create mask files.  As a 
starting point, you can use this data to create sample upper_mask.trc and 
lower_mask.trc files. 

 

3. From the file menu, click Save As.  The Save As dialog box displays. 

4. From Save in, navigate to C:>Program files>Spectrum Analyzer 

5. From Save as type, click the drop down arrow and choose All Files. 

6. From File Name, type upper_mask.trc and click the Save button.  

 

7. To create the lower mask file, from File>New, repeat steps 3 through 6 and 
type lower_mask.trc in the file name field, then click the Save button. 
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Loading Mask Files 

To load the upper and lower mask, from the Menu Bar point to Marker > 
Mask > Upper or Lower > Load.  

Line Marker Mask Menu 

 

· Choose Upper > Load to load trace data files. 
o Find the saved lower mask file and click Open 

 

 
 

· Choose Lower > Load to load trace data files.  
o Find the saved lower mask file and click Open 
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Display of Upper and Lower Masks Loaded in SACP 
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Alarm is activated due to violation 
   

 
 

To remove the trace data file: 
 
Click Mask>Upper or Lower>Remove 
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Display of the upper trace removed and the lower trace still active 
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8. WORKING WITH MEASURE 
FUNCTIONS  

Using Bandwidth Markers  

From the Marker menu, you can choose 3 dB, 6 dB, or 60 dB bandwidth markers. Point 
Markers are placed on each side of the current frequency at 3, 6, or 60 dB lower than the 
current peak. Follow these instructions to activate bandwidth markers.  

 
To activate Bandwidth Markers  

 
1. From the Marker menu measure functions segment, point to 3 dB, 6 dB, or 60 

dB. A check mark displays next to the function. Point Markers A and B 
display on the Instrument Configuration.  

Measure Functions segment of Marker Menu 

 

NOTE:  Point Markers are displayed on a sweep at frequencies lower than the current 
peak.  

 
2. To disable Bandwidth Markers choose Marker > MarkerA > Hide , then 

Marker > Marker B > Hide .  

Setting Threshold  
You can limit your Point Markers to values above the instrument’s noise floor by 
choosing Set Threshold from the Marker menu. Follow these instructions to activate 
Set Threshold.  
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To activate Set Threshold  
  

1. Activate a Point Marker, or choose a measure function. For more information, 
see “Activating a Point Marker, page 52.”  
 

2. From the Marker menu, choose Set Threshold.  

Marker > Set Threshold 

 

3. The built in calculator displays.  

Calculator 

 

 
4. Enter the Marker Threshold number by clicking the appropriate keys on the 

calculator, then click the dBm button.  
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9. CUSTOMARY MENUS  

Common Menus  
SA Control Panel has several common Microsoft Windows menus including, File, Edit, View, 
Tools, Window, and Help. The following Overview gives a description of these menus, and menu 
items. Many of the menu items are unique to Spectrum Analysis.  

 

File Menu  

File Menu 

 

From the File Menu, you can:  
 

· Choose New to start a new blank Instrument Configuration on the 
workspace. 

· Choose New Copy to copy existing document to create a new document. 

· Choose Open to open an existing Instrument Configuration from a 
directory.  

· Choose Save to save a completed Instrument Configuration to a directory.  
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· Choose Save As to save a completed Instrument Configuration as a new 
name.  

· Choose Close to exit an Instrument Configuration.  

· Choose Set Protection to prevent other users from modifying an 
Instrument Configuration.  

· Choose Print Setup to set printing properties for an Instrument 
Configuration.  

· Choose Print Preview to view an Instrument Configuration before 
printing.  

· Choose Print to print a hard copy of an Instrument Configuration.  

· Choose Send>Configuration to attach an Instrument Configuration to an 
email, or choose Picture to attach an Instrument Configuration as a .png 
file to an email. PNG files can be opened with most graphics software 
programs, or inserted into desktop publishing programs for printing or 
viewing.  

· The items listed next are saved Instrument Configurations. From this list, 
you can choose any saved Instrument Configuration to open it on the 
workspace.  

· Choose Exit to leave SA Control Panel.  

· For information on the Trace Menu, see “Using the Trace Menu” on page 
40.  

Edit Menu  
The Edit menu is inactive, and will be available in a future release of the software.  

View Menu  

View Menu 
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From the View menu, you can:  

· Choose Tools to start the Tool Options bar.  

· Choose Marker Bar to start the Marker Options bar.  

· Choose Status Bar to start the Status Bar at the bottom of the workspace.  

· Choose Actual Size to restore a zoomed horizontal, vertical (or both) 
signal trace back to its original size.  

 
· Choose Spectrogram to show an image of how the spectral density of a 

signal varies with time. 
 

Display of Spectrogram   Display of Active Trace 
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Preset Bar 
· Choose Preset Bar to view saved configurated traces to select directly 

from SACP. 
 

 
 

· Click on the Select Site button to load the Preset bar 
 

 
 

· Select the file and select  
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Display of Selected Sites 
 

 
 

· Click on Trace and the saved configuration will appear 
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· Highlight the trace and click Add Selected 
 

 
 

Display of the Configured Trace 
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Zoom Menu  

Once an Instrument Configuration trace is setup, you can click and drag a rectangle 
on a specific trace area and zoom vertically, horizontally, or both, to the area you 
want to view. When you click and drag a rectangle on a trace, the Zoom Menu 
displays.  

Zoom Menu 

 

From the Zoom Menu, you can:  
 

· Choose Zoom Horizontal to enlarge a specific area on a trace 
horizontally.  

· Choose Zoom Vertical to enlarge a specific area on a trace vertically.  
· Choose Zoom Both to enlarge a specific area on a trace horizontally and 

vertically.  
 

Set Instrument Commands  
You can quickly reconfigure an instrument to an exact location on a trace using the 
Set Instrument commands on the Zoom Menu.  
 
To reconfigure the instrument frequencies, reference level, or both, click and drag a 
rectangle on the location of the trace you want to view, choose Set Instrument 
Frequencies, Set Instrument Reference Level, or Set Both to quickly reset the 
instrument to the new location parameters.  
 

· Drag a rectangle on the Instrument Configuration, then choose Set 
Instrument Frequencies to change the center frequency to a different 
area.  

· Drag a rectangle on the Instrument Configuration, then choose Set 
Instrument Reference Level to change the reference level.  
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· Drag a rectangle on the Instrument Configuration, then choose Set Both to 
change the center frequency, span, and reference level.  

 
Set Markers Commands  

You can quickly add Point and Line Markers to an exact location on a trace using the 
Set Markers commands on the Zoom Menu. 

· Drag a rectangle on the Instrument Configuration trace, then choose Set 
Markers A and B to place the Point Markers on an area of the trace.  

· Drag a rectangle on the Instrument Configuration trace, then choose Set 
Markers 1 and 2 to place the Line Markers on an area of the trace.  

· For information on the Marker Menu, see “Working with Markers” on 
page 33.  

Tools Menu  

Tools Menu 

 

From the Tools Menu, you can:  
· Choose Preferences to start the Preferences dialog box. From the 

Background tab, you can change the background color of any Instrument 
Configuration. Click Change to start the Windows Basic Color dialog 
box. Choose a new color from the color blocks, or create your own custom 
color.  

Preferences dialog box - Background Tab 
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Preferences dialog box - Grid Tab 

 

From the Grid tab, you can:  
 

· Choose the Hide check box, then click OK to hide the grid on any 
Instrument Configuration.  

· Click Change to start the Windows Basic Color dialog box, and change 
the grid color on any Instrument Configuration. Choose a new color from 
the color blocks, or create your own custom color.  

· Highlight and change the number in Horizontal Divisions, then click OK 
to change the horizontal grid divisions on any Instrument Configuration.  

· Highlight and change the number in Vertical Divisions, then click OK to 
change the vertical grid divisions on any Instrument Configuration.  

· Highlight and change the number in Units Per Division, then click OK to 
change the amplitude units on any Instrument Configuration. The dBm 
option bar changes and displays the new number.  

· Under the tools menu you can click the Alarms Audible to 
activate/deactivate audible alarm. 
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Window Menu  

Window Menu 

 

From the Window Menu, you can:  
 

· Choose New Window to start a new blank Instrument Configuration 
window.  

· Choose Cascade to distribute multiple Instrument Configuration windows 
in a waterfall display. See “Cascade” for an example of this layout.  

· Choose Tile to distribute multiple Instrument Configuration windows in a 
side by side, horizontal or vertical display. See “Tile > Vertical” or “Tile > 
Horizontal” for examples of this layout.  

· The items listed next are the unsaved Instrument Configuration(s) active 
on the workspace.  

Cascade 
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Tile > Vertical 

 

Tile > Horizontal 

 



VigilCom® User’s Manual  Version 2.0 �� ������� �
 

Help Menu  

Help Menu 

 

You can locate the SA Control Panel User Manual, inside the program by clicking  
Help > PDF User Manual. The program CD also has a copy of the PDF User Manual. 
You can print either version, or use the online version within the program.  

From the Help menu, you can: 

· Choose Help > PDF User Manual to start the User Manual in Adobe 
Reader.   

· Choose About Spectrum Analyzer to view version and copyright 
information.  

NOTE:  All dimmed options are disabled menu items and available in a future release of the 
software. 
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10. CARRIER MONITOR WEB 
INTERFACE  

Introduction 

A web browser is used to configure carriers and acceptable operating parameters, to 
observe current operational characteristics of the carriers, and to manage alarms. This 
is often a cost-effective alternative when there is no existing network operations 
center. The Web-based Utility must be used to add or remove transponders, carriers 
and individual signals. 

The Utility’s Status pages allow the user to observe the current operational state and 
to manage alarms that are generated when signals fall outside specified parameters. 
Configuration pages are provided the user with the ability to add, remove, and 
configure the signals of interest (transponders and carriers) and to specify the ranges 
of acceptable operating parameters. 

The following sections describe how to access, configure and use the Carrier 
Monitoring System via the Web-based Utility. 

Simple Network Management Protocol (SNMP) 

The Simple Network Management Protocol (SNMP) is used to communicate 
configuration data, current operational parameters, and alarms between the remotely 
located Tampa Microwave carrier monitoring instruments and the customer’s 
network operating center. SNMP allows a network operating center to integrate 
management of the quality and status of the radio frequency portions of the network 
as easily as the wired portions of the network. 

Configuration and operational parameters are transmitted to and from the Tampa 
Microwave instruments using GET and SET commands. SET commands transmit the 
data that is used to configure a carrier (carrier center frequency and bandwidth) and to 
enable an alarm (threshold value). GET commands retrieve the configuration 
information and current operational parameters (measured carrier frequency and 
bandwidth, carrier power, CNR, etc.). 

The Tampa Microwave Carrier Monitoring System notifies the management system 
when alarm conditions occur by transmitting an SNMP TRAP. The data contained in 
the trap indicates the type of alarm that occurred, the carrier where the condition was 
observed, the threshold and measured values, and a time stamp. 

Additionally, an operator at the network operating center can temporarily suspend 
monitoring activities to open a traditional spectrum analyzer front panel and perform 
a detailed analysis of the carrier signal in real-time. 
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Accessing the Web-based Utility 

To access Web-based Utility, you will need to know the host name or IP address of 
the Carrier Monitoring System. The default host name for each system is the system’s 
serial number. If this has been changed or your network does not support automatic 
registration of host names, you may need to check with your network administrator to 
obtain this information.  

Launch your Web browser and type in the URL, http://hostname/cmweb in the 
Address field, replacing “hostname,” with the host name or IP address of your Carrier 
Monitoring System. 

NOTE:  The Web-based Utility works best with Microsoft Internet Explorer Version 6.0 or 
later, and Firefox Version 2.0 or later. 

 

Log In page 

 

The Web-based Utility launches the Log In page.  From here you must enter User 
Name and Password below: 

User Name:   administrator  

Password: Admin_01 

Click Log In 
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Carrier Monitor Status Display 

 

NOTE:   There is no signal status since there are no measurements being recorded.   

This page displays the Date, Time and Refresh page option.  This page is currently set 
to refresh its data every 10 seconds.  Select a page refresh rate of 5, 10, 15, 30 or 60 
seconds, or turn off the refresh function.   

Carrier Monitor Menu 

 

Signal Status:  Displays the most recently measured operating parameters for all 
transponders and carriers entered by the user.  

Alarms:  Once carrier and transponder settings are established, the Alarms page 
shows alerts based on limits set by the user in the Carrier and Transponder 
Configuration pages  
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Logged Traces:  Each time a measurement is made for each individual signal, the 
trace data is saved. 

Schedule: Add a schedule to configure a schedule for the passplan(s). 

Passplans: Create a Passplan to show operating state of signals and transponders 

Parameters: Configure measurements and statistics 

Logout:  This selected menu will log out from the Carrier Monitor Web Interface 

Configure Application Parameters and SNMP Alarms 

 

Parameters and SNMP Configuration Display 

 

Delete Alarms Older Than: This field specifies the number of days that generated 

alarms are retained by the carrier monitor system (recommend no longer than 7 days). 

 

Delete Logged Traces Older Than: This field specifies the number of days that 
spectrum trace data is retained by the system. 

 

Minimum Interval Between Measurements: This field specifies the how often an 
alarm is transmitted for a condition that remains continuously active. 
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Average Statistics For:  This field specifies a period of time over which to average 
measurements before they are reported.  When this field is non-zero, all 
measurements reported (including maximum, minimums, and averages) are based on 
the average measurement observed over the period of time specified. 

Configure SNMP Alarms 

This page is used to configure the systems to which alarms are transmitted when 
using the SNMP protocol. 

 

Enable SNMP Alarms: Check box to enable SNMP alarms or uncheck to disable  

alarms. 

 

Retransmit alarms still active after: This field specifies how often an alarm is  

transmitted for a condition that remains continuously active.  Since the SNMP  

protocol does not guarantee receipt of alarms, alarms that remain active are  

retransmitted to insure they are “seen” by the management system. 

 

Purge untransmitted alarms older than: this field specifies the number of days that 

generated alarms are retained by the carrier monitor system. 

 

Passplan Configuration 
�

Passplan Display 

�
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Click on New Passplan to create a Passplan 

 

 

 

 

 

Edit Passplans Display 

�

Enter Passplan Name and click Save 

NOTE: You can also click on Browse… to upload an already saved Passplan 
configuration to view or edit. 

In the menu, click on Passplans and the newly created Passplan OR uploaded Passplan is 
displayed. 

Passplans Display 
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�

Click Edit to change the name of the Passplan OR click Delete to delete the Passplan. 

Click New Passplan to create a Passplan 

�

Configure Signals 
  

Click New to create a Signal 

Passplans Display Ready to Add New Signal(s) 

 

 

Signal Parameters Display 
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Name:  Enter the user-defined name for the signal.    

Input:   Enter the instruments input (1-8) where the signal can be detected.   

Center Frequency:  Enter the expected center frequency of the carrier.  To change the 
value, click on the drop down button to select Hz, kHz, MHz and GHz. 

Bandwidth:  Enter the frequency range reserved for the carrier, typically including any 
guard bands that prevent interferences with adjacent carriers.  To change the value, click 
on the drop down button to select Hz, kHz, MHz and GHz. 

Reference Level:  Set the reference level to the Marker amplitude. 

Auto RBW:  Check box to automatically measure the ratio between VBW and RBW. 

RBW:  Resolution Bandwidth Filter. A bandwidth dependent filter used to resolve 
individual signals. The narrower the RBW, the more noticeable the separation of two 
signals. To change the value, click on the drop down button to select Hz, kHz and MHz. 

Auto VBW:   Check box to automatically measure the ratio between VBW and RBW. 

VBW:   Video Bandwidth Filter. Used to reduce or eliminate noise of the signal.  To 
change the value, click on the drop down button to select Hz, kHz and MHz. 

VBW Ratio:  Enter the VBW Ratio 
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Data Rate:  Enter the expected bit-rate for data transmitted on the carrier and is used in 
the calculations of the Eb/N0 measurement for the carrier.  To change the value, click on 
the drop down button to select bps, kbps, Mbps. 

Click Save when finished 

In the Menu, click on Passplan to view signals created. 

From this page you can edit, delete or create a new signal 

Signal(s) Displayed in Passplans 

 

 

Add Transponders 
 

Click NEW to configure a Transponder 

Transponder Configuration Display 

�

Name:  Enter the user-defined name for the Transponder.    
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Input:   Enter the instruments input (1-8) where the signal can be detected.   

Center Frequency:  Enter the expected center frequency of the carrier.  To change the 
value, click on the drop down button to select Hz, kHz, MHz and GHz. 

Bandwidth:  Enter the frequency range reserved for the carrier, typically including any 
guard bands that prevent interferences with adjacent carriers.  To change the value, click 
on the drop down button to select Hz, kHz, MHz and GHz. 

Click Save when finished 

In the Menu, click Passplan to view Transponder(s) created. 

From this page you can edit, delete or create a new Transponder. 

 

 

 

 

 

Signal(s) and Transponder(s) Displayed in Passplans 

�

Add Carriers 
 

Click New Carrier to create a Carrier 

Carrier Configuration Display 
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�

Name:  Enter the user-defined name for the signal.    

Input:   Enter the instruments input (1-8) where the signal can be detected.   

Center Frequency:  Enter the expected center frequency of the carrier.  To change the 
value, click on the drop down button to select Hz, kHz, MHz and GHz. 

Bandwidth:  Enter the frequency range reserved for the carrier, typically including any 
guard bands that prevent interferences with adjacent carriers.  To change the value, click 
on the drop down button to select Hz, kHz, MHz and GHz. 

Data Rate:  Enter the expected bit-rate for data transmitted on the carrier and is used in 
the calculations of the Eb/N0 measurement for the carrier.  To change the value, click on 
the drop down button to select bps, kbps, Mbps. 

Click Save when finished 

In the Menu, click on Passplans to view Carrier(s) created. 

From this page you can edit, delete or create a New Carrier. 

Passplans Display�
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�

Additional Carrier Added�

�

Click Edit  

Change Passplan Name or download configuration 

Once you are completed with configuring your settings, click Edit  by the Passplan. This 
will take you back to the Edit Passplan page. 

Edit Passplan Dislay 
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�

From here you can save the Passplan by clicking Download Configuration.  The file 
will be saved in a .txt format. 

�

Click Open, Save or Cancel  

You can save the file to later upload the configured Passplan. 

 

Schedule Configuration 
�

Schedule Display 
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�

Click Add Schedule Entry to configure a schedule for your Passplan�

Configure Schedule Display 

�

Enter Next Start Date & Time (click on the up/down arrow or type in the date and time). 

Run for:  Enter amount of time you want the schedule to run for.  Click drop down button 
to choose from Seconds, Minutes, Hours, Days, Weeks, Months or Years. 

Repeat Every:  Enter amount of time you want to repeat the schedule.  Click drop down 
button to choose from Seconds, Minutes, Hours, Days, Weeks, Months or Years. 

Check the box to include the Passplan in order for the schedule to work. 
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* If you click the Show button, this will take you back to the Passplan page. 

Click Update or Cancel when you are finished 

Schedule Entry Display 

 

From this page, you can Edit , Delete OR Add another schedule entry. 

From the Menu, click on Signal Status to view Monitored Signals and Transponders 

Signal Status 
This page displays the most recently measured operating parameters for all 
transponders and carriers entered by the user.  

By default, the page is set to refresh every 10 seconds.  You can click to select a page 
refresh rate of 5, 10, 15, 30, or 60 seconds, or turn off the refresh function. 

 

 

Signal Status Display of Schedule 
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· Under Monitored Transponders, click the  of the Transponder 1 that 
was created and this will display the statistics of the signal. 

 

 

 

 

 

 

 

 

 

 

 

Logged Traces 
�
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From this page, it shows the Signal created. 

Each time a measurement is made for each individual signal, the trace data is saved. 

Logged Traces Display 

 

Signal:  Select a signal (choose all signals or specific signal from the list) 

 

Start Date/Time:  Enter the date and time to start trace by entering the month/day/year 
for the date, and hours/minutes and whether AM or PM. 

End Date/Time:  Enter the date and time to end trace by entering the month/day/year for 
the date, and hours/minutes and whether AM or PM. 
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Delete Selected:  Check the signal(s) you want to delete and click the Delete Selected 

Display Selected: Check the signal(s) you want to display and click Display Selected 
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Download Selected:  Check the signal(s) to save or open into an .xml file 

Download All:  By selecting this button, all the signals will be saved or opened into an 
.xml file 

 

Click Apply Filter  when finished 
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Alarms 
Once carrier and transponder settings are established, the Alarms page shows alerts 
based on limits set by the user in the Carrier and Transponder Configuration pages. 

By default, the page is set to refresh every 10 seconds.  You can click to select a page 
refresh rate of 5, 10, 15, 30, or 60 seconds, or turn off the refresh function. 

Alarms Display 

 

In the menu, click Passplans to set up alarms 

 

 

Chose a signal and click Edit 
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Selected Carrier Thresholds: The Carrier Thresholds table shows whether alarms are 
enabled based on the carrier measurements and the values that cause alarms to be raised 
for the selected carrier. The figure below shows how the four thresholds divide the range 
of measurements.  

· Measurement values that exceed the Maximum Value field cause a “Max 
Exceeded”  

· alarm to be generated. 

· Measurement values between the High Value and Maximum Value fields 
cause a “  

· Low Exceeded” alarm to be generated. 

· Measurement values between the Low Value and Minimum Value fields 
cause a 

· “Low Exceeded” alarm to be generated. 

· Measurement values less than the Minimum Value field cause a “Low 
Exceeded”  

 
Threshold  
Exceeds 

acceptable 
limit Maximum Value field. 
High 
value High Value field. 

 
Acceptable 

range 
 

 

Low 
value 

Low Value field. 

Below Minimum Value  field. 
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acceptable 
limit 

 

Alert Type:  This column specifies the type of measurement to which the threshold 
values apply.  

· Power – the total integrated power measured within the configured bandwidth. 

· Center Frequency – the middle frequency with the range of frequencies that 
comprise the measured bandwidth.  Use the drop-down button to choose Hz, 
kHz, MHz, GHz. 

· Bandwidth – the width of the contiguous range of frequencies that produced 
99% of the measured power within the configured bandwidth.  Use the drop-
down button to choose Hz, kHz, MHz, GHz.  

· C/N – the ratio of the measured power to the integrated noise power 
measured, the carrier-to-noise ratio. (Note that the noise power is estimated 
based on the noise levels adjacent to the carrier). 

· Eb/N0 – the Bit Energy-to-Noise Density ratio computed by applying the 
specified data rate to the measured bandwidth and C/N. 

· SignalMask – Min/Max setting if signal reaches above or below setting, it will 
signal an alarm. 

 
Click Save when finished 

SignalMask  
�

�  Check the box and click Edit  
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From this screen you can: 

 

Browse.. :  Select a saved file and upload 

 

Add New Entry:   Add Frequency and Amplitude and then click Insert. 

 

 
You can Edit or Delete entry or Add more 

 

Once you are finished, click Download if you want to save or open this Mask in .txt file. 
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From the Menu, click Alarms 

�

This page will show the Signal, the Alarm Type, Measured Value, Threshold Value, 
Count, Start of when the alarm occurred and Clear of when the alarm was cleared. 
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A. APPENDIX 

VC1800 Specification  

 
Frequency Specifications  
 
Input Frequency Range - 100kHza – 1.8GHz 

  TCXO OCXO (Option) 
Frequency Reference 
   Frequency reference error = ± [(aging rate x time since last adjustment) + settability +  
   temperature stability] 
   Frequency readout accuracy (start, stop, center, marker) = ± ((Center frequency x  
   frequency reference error) + 4kHz ± RBW/3) 
   Aging     ±1x10-6/year    ±1x10-7/year 
   Temperature stability    20
 C – 30
 C    ±1.5x10 -7    ±1.4x10-9 
    0
 C – 50
 C    ±7.4x10 -7    ±7.2x10-9 
   Settability     3.8x10-10    1.5x10-10 
   External Reference Input    10MHz    50�   -10dBm to +10dBm (characteristic) 
Frequency Span 
   Range = 2Hz to maximum frequency range of the analyzer 
   Accuracy = ± (Span x Frequency Reference Error) ± RBW/3 
   Frequency Resolution 1Hz 
Instantaneous Bandwidth (Stare) 
   Range (6dB)    40MHzb 
Resolution Bandwidths C 
   Range (-3dB)    3Hz – 1MHz Continuously Variable 
   Accuracy    ± 5% 
   Selectivity (60dB/3dB  
   bandwidth ratio) 

   4:1 digital, approximately Gaussian 

Stability 
   Noise sidebands offset from CW signal with 1kHz RBW 
   Frequency    Offset from CW signal    Spec, typical dBc/Hz 
   < 40MHz    ³ 10kHz    -120, -130dBc/Hz  
   40MHz – 1.8GHz    ³ 10kHz    -82, -90dBc/Hz 
Residual FM (peak-to-peak) 
   1kHz RBW, (measurement 
   time) 

   £150Hz (100ms) 

������������������������������������������������ �
a.   9kHz Characteristic. 
b.   At 70MHz IF 
c.   For RBW £  300kHz 
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System Related Sidebands 
   ³ 30kHz offset from carrier CW signal £ -65dBc 

 

 
 
Amplitude Specifications  
 

Amplitude Range 
   Measurement Range    Displayed average noise level (DANL) to maximum safe  

   input level 
   Input attenuator range    0 – 60dB, (1dB steps) 
Maximum Safe Input Level 
   Average continuous powera    +20dBm (100mW) 
   DC Voltage    0 VDC 

 
Gain Compression 2 Tone b 
   Total mixer power –30dBm    <1dB 

 
Displayed Average Noise Level (dBm), Noise Figure ( dB) Typical 
 Front end amp off c Front end amp on d e 
Frequency DANL Noise figure DANL Noise figure 
   100kHz – 40MHz    -143    11    -143    11 
   40MHz – 500MHz    -132    22    -143    11 
   500MHz – 1GHz    -131    23    -142    12 
   1GHz – 1.8GHz    -127    27    -138    16 

 
Display 
   Display range    0.01 – 20dB/div 
   Vertical divisions    Continuously variable 
   Scale units    dBm 
   Trace functions    Clear/write, max. hold, min. hold, average  
Reference Level 
   Range    -150dBm - +20dBm 

 
Amplitude Accuracy 
   At reference level f h    ± 0.5dB 
   Overall amplitude accuracy g h     ± 1.5dB 

 

������������������������������������������������ �
a.   0dB input attenuation. 
b.   As measured with reference level signal when 2nd tone input @ 10dB above reference level.  
c.   100Hz RBW, input terminated, 0dB front end attenuation  
d.   Front end amp engages for reference levels £ -50dBm. 
e.   100Hz RBW, input terminated, 0dB front-end attenuation, front-end amp on. 
f.   Settings are: Reference level –30dBm; input attenuation 10dB, center frequency 1GHz; RBW 1kHz; span 30kHz;    
     20 to 30°C.  Input power at –30dBm. 
g.  For reference level +20 to –30dBm, RBW 1kHz, RBW 1kHz, span 30kHz (20 to 30°C). Input level +20 to –30dBm. 
h.  When unit has 8 port coax switch; switch insertion loss is not calibrated out.  
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Spurious Responses 
   Third Order Intercept (dBm) (Typical)  
   Frequency Front end amp off 1  Front end amp on 2 3 
   100kHz – 40MHz    +12    +12 
   40MHz – 500MHz    +10    -3 
   500MHz – 1GHz    +11    -2 
   1GHz – 1.8GHz    +12    0 
Other Input Related Spurious 
   In band > 30kHz offset 4    < -65dBc 
   Residual responses 5    < -90dBm 

 

Internal Switch  6 
 

Insertion Loss (dB) 
  100KHz-1800MHzh 3.0 Typ    4.0 Max 
Isolation 
Input (off) to Output g  
  100KHz-1800MHz 100dB Typ;  80 dB Min 
VSWR 
100kHz – 1.8 GHz >1.5 

 
 
 
 
 
 
 
 
 
 
 

������������������������������������������������ �

 
a.  For two -50dBm signals at mixer input and greater than 150kHz separation.  Mixer input defined as input power 
     (dBm) – input attenuation (dB). 
b.  Front amp engages for reference levels £ -50dBm 
c.  For two -50dBm signals at mixer input and greater than 150kHz separation.  Mixer input defined as input power 
     (dBm) – input attenuation (dB) + 10dB. 
d.  Input > 40MHz. 
e.  Input terminated 0dB front end attenuation and front end Amp engaged. 
f.   Optional. 
g.   Input port is terminated with 50 ohms. 
h.  Switch insertion loss is not calibrated out. 
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General Specifications  
 

Temperature Range 
   Operating     0° C to 50° C 
   Storage    -20° C to 65° C 
   Disk drive    5° C to +55° C 
   Max temperature gradient    20° C/hour 
Relative Humidity 
   Operating    8 to 90% non-condensing 
   Storage    5 to 95% non-condensing 
Altitude 
   Operating     15000 feet @ 0° C to 40° C 
   Storage    50000 feet @ 0° C to 25° C 
Altitude Hard Disk 
   Operating a    10000 feet 
   Storage    14000 feet 
Power Requirements b 
    100 – 240 VAC, 50 – 60 Hz, 2 Amps 
   +24VDC @ 3.5 amps max  
   +28VDC (+20 to +34 VDC) (Option) 
Communication Interface 
   10/100 Ethernet  
   USB 2.0  
Protocol 
   TCP/IP  
Inputs/Outputs 
   Input    50 �  SMA (f) 
   10MHz REF OUT    50 �  SMA (f), > +5dBm (characteristic) 
   10MHz REF IN    50 � , -10 to +10dBm (characteristic) 
   VGA Interface    Standard VGA Connector 
   Parallel interface    25 pin D-SUB (f) 
   USB 2.0    USB Type A 
   Ethernet 10/100    RJ-45 
Dimensions, Weight 
   Rack mount form factor     19” 1 RU 20” deep, 14 pounds 
   Compact form factor     10” x 11.75” x 3.75”, 12 pounds 

 
 
�
 
 
 
 
 
�

������������������������������������������������ �
a.   Contact factory for details. 
b.   Contact factory for custom input voltage requirements. 
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Definitions and conditions 
 

· Specifications describe the performance of parameters covered by the product warranty.  
(The temperature range is 0
 C to 50
 C, unless otherw ise noted). 

· Characteristics describe product performance that is useful in the application of the 
product, but is not covered by the product warranty. 

· Typical performance describes additional product performance information that is not 
covered by the product warranty.  It is performance beyond specification that 80% of the 
units exhibit with a 95% confidence level over the temperature range 20
 C to 30
 C.  
Typical performance does not include measurement uncertainty. 

· Nominal values indicate the expected performance, or describe product performance 
that is useful in the application of the product, but is not covered by the product warranty. 

· Product specifications and descriptions in this document are subject to change without 
notice. 

 

The following conditions must be met for the analyzer to meet its specifications. 

 

· The analyzer is within the one-year calibration cycle. 

· When the analyzer is at a constant temperature, within the operating temperature range, 
for a minimum of 90 minutes. 

· After the analyzer is turned on for a minimum of 90 minutes. 
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B. APPENDIX 

VC3500 Specification  

 
Frequency Specifications  
 
Input Frequency Range100kHza – 3.5GHz 
 

  TCXO OCXO (Option) 
Frequency Reference 
   Frequency reference error = ± [(aging rate x time since last adjustment) + settability +  
   temperature stability] 
   Frequency readout accuracy (start, stop, center, marker) = ± ((Center frequency x  
   frequency reference error) + 4kHz ± RBW/3) 
   Aging     ±1x10-6/year    ±1x10-7/year 
   Temperature stability    20
 C – 30
 C    ±1.5x10 -7    ±1.4x10-9 
    0
 C – 50
 C    ±7.4x10 -7    ±7.2x10-9 
   Settability     3.8x10-10    1.5x10-10 
   External Reference Input    10MHz    50�   -10dBm to +10dBm (characteristic) 
Frequency Span 
   Range = 2Hz to maximum frequency range of the analyzer 
   Accuracy = ± (Span x Frequency Reference Error) ± RBW/3 
   Frequency Resolution 1Hz 
Instantaneous Bandwidth (Stare) 
   Range (6dB)    40MHzb 
Resolution Bandwidths C 
   Range (-3dB)    3Hz – 1MHz Continuously Variable 
   Accuracy    ± 5% 
   Selectivity (60dB/3dB  
   bandwidth ratio) 

   4:1 digital, approximately Gaussian 

Stability 
   Noise sidebands offset from CW signal with 1kHz RBW 
   Frequency    Offset from CW signal    Spec, typical dBc/Hz 
   < 40MHz    ³ 10kHz    -120, -130dBc/Hz  
   40MHz – 3.5GHz    ³ 10kHz    -88, -95dBc/Hz 
Residual FM (peak-to-peak) 
   1kHz RBW, (measurement 
   time) 

   £150Hz (100ms) 

������������������������������������������������ �
a.   9kHz Characteristic. 
b.  At 70MHz IF 
c.  For RBW £  300kHz 



VigilCom® User’s Manual  Version 2.0 �� �������� �
 

System Related Sidebands 
   ³ 30kHz offset from carrier CW signal £ -65dBc 

 

Amplitude Specifications  
 

Amplitude Range 
   Measurement Range    Displayed average noise level (DANL) to maximum safe  

   input level 
   Input attenuator range    0 – 60dB, (1dB steps) 
Maximum Safe Input Level 
   Average continuous powera    +20dBm (100mW) 
   DC Voltage    0 VDC 

 
Gain Compression 2 Tone b 
   Total mixer power –30dBm    <1dB 

 
Displayed Average Noise Level (dBm), Noise Figure ( dB) Typical 
 Front end amp off c Front end amp on d e 
Frequency DANL Noise figure DANL Noise figure 
   100kHz – 40MHz    -143    11    -143    11 
   40MHz – 500MHz    -133    21    -145      9 
   500MHz – 2GHz    -132    22    -142    12 
   2GHz – 3GHz    -128    26    -139    15 
   3GHz – 3.5GHz    -125    29    -136    18 

  
 

Display 
   Display range    0.01 – 20dB/div 
   Vertical divisions    Continuously variable 
   Scale units    dBm 
   Trace functions    Clear/write, max. hold, min. hold, clear operation 
Reference Level 
   Range    -150dBm - +20dBm 

 
Amplitude Accuracy 
   At reference level f h    ± 0.5dB 
   Overall amplitude accuracy g 7    ± 1.5dB 

������������������������������������������������ �
a.   0dB input attenuation. 
b.   As measured with reference level signal when 2nd tone input @ 10dB above reference level.  
c.   100Hz RBW, input terminated, 0dB front end attenuation  
d.   Front end amp engages for reference levels £ -50dBm. 
e.   100Hz RBW, input terminated, 0dB front-end attenuation, front-end amp on. 
f.   Settings are: Reference level –30dBm; input attenuation 10dB, center frequency 1GHz; RBW 1kHz; span 30kHz;    
     20 to 30°C.  Input power at –30dBm. 
g.  For reference level +20 to –30dBm, RBW 1kHz, RBW 1kHz, span 30kHz (20 to 30°C). Input level +20 to –30dBm. 
h.  When unit has 8 port coax switch; switch insertion is not calibrated out. 
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Spurious Responses 
   Third Order Intercept (dBm) (Typical)  
   Frequency Front end amp off a  Front end amp on b c 
   100kHz – 40MHz    +12    +12 
   40MHz – 500MHz    +11       -2 
   500MHz – 2GHz    +12        0 
   2GHz – 3GHz    +14      +2 
   3GHz – 3.5GHz    +15      +4 

 
Other Input Related Spurious 
   In band > 30kHz offset d    < -65dBc 
   Residual responses e    < -90dBm 

 

Internal Switch  f 
 

Insertion Loss (dB) 
  100KHz-1800MHzh 5.0 Typ    6.0 Max 
Isolation 
Input (off) to Output g  
  100KHz-1800MHz 100dB Typ;  80 dB Min 
VSWR 
100kHz – 1.8 GHz >1.5 

 
 
 

 

 

 

 

 
 
������������������������������������������������������������������������������������������������������������������������������������������������������������ �
 
a.   For two -50dBm signals at mixer input and greater than 150kHz separation.  Mixer input defined as input power   
     (dBm) – input attenuation (dB). 
b.   Front amp engages for reference levels £ -50dBm. 
c.   For two -50dBm signals at mixer input and greater than 150kHz separation.  Mixer input defined as input power   
     (dBm) – input attenuation (dB) + 10dB.  
d.   Input > 40MHz  
e.   Input terminated 0dB front end attenuation and front end Amp engaged 
f.   Optional. 
g.   Input port is terminated with 50 ohms. 
h.  Switch insertion loss is not calibrated out. 
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General Specifications  
 

Temperature Range 
   Operating     0° C to 50° C 
   Storage    -20° C to 65° C 
   Disk drive    5° C to +55° C 
   Max temperature gradient    20° C/hour 
Relative Humidity 
   Operating    8 to 90% non-condensing 
   Storage    5 to 95% non-condensing 
Altitude 
   Operating    15000 feet @ 0° C to 40° C 
   Storage    50000 feet @ 0° C to 25° C 
Altitude Hard Disk 
   Operating8    10000 feet 
   Storage    14000 feet 
Power Requirements b  
    100 – 240 VAC, 50 – 60 Hz, 2 Amps 
   +24VDC @ 3.5 amps max  
   +28VDC (+20 to +34 VDC) (Option) 

 
 

General Specification Continued 
Communication Interface 
   10/100 Ethernet  
   USB 2.0  
Protocol 
   TCP/IP  
Inputs/Outputs 
   Input    50 �  SMA (f) 
   10MHz REF OUT    50 �  SMA (f), > +5dBm (characteristic) 
   10MHz REF IN    50 � , -10 to +10dBm (characteristic) 
   Parallel interface    25 pin D-SUB (f) 
   USB 2.0    USB Type A 
   Ethernet 10/100    RJ-45 
Dimensions, Weight 
   Rack mount form factor     19” 1 RU 20” deep, 16 pounds 
   Compact form factor    10” X 11.75” X 3.75”, 12 pounds 

 

 

 

 
������������������������������������������������ �
8.  Contact factory for details 
b.  Contact factory for custom input voltage requirements. 
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Definitions and conditions 
 

· Specifications describe the performance of parameters covered by the product warranty.  
(The temperature range is 0
 C to 50
 C, unless otherw ise noted). 

· Characteristics describe product performance that is useful in the application of the 
product, but is not covered by the product warranty. 

· Typical performance describes additional product performance information that is not 
covered by the product warranty.  It is performance beyond specification that 80% of the 
units exhibit with a 95% confidence level over the temperature range 20
 C to 30
 C.  
Typical performance does not include measurement uncertainty. 

· Nominal values indicate the expected performance, or describe product performance 
that is useful in the application of the product, but is not covered by the product warranty. 

· Product specifications and descriptions in this document are subject to change without 
notice. 

 

 
 

 

The following conditions must be met for the analyzer to meet its specifications. 

 

· The analyzer is within the one-year calibration cycle. 

· When the analyzer is at a constant temperature, within the operating temperature range, 
for a minimum of 90 minutes. 

· After the analyzer is turned on for a minimum of 90 minutes. 
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GLOSSARY 

Add Trace: Dialog Box used to add extra traces to an Instrument Configuration.  
 
Average: A trace type that tracks and displays an average of the amplitude at each frequency.  

B  

Basic Color Box: Use to change the color of traces added to an Instrument Configuration. From 
the Trace > Properties dialog box, you can access it by clicking the Change button.  

C  

Center Frequency: The frequency that exists in the center of a sweep.  
 
Clear: Temporarily removes Max Hold and Min Hold on a trace for one sweep. Thereafter, Max 
and Min Holds resume.  

H  

Horizontal Divisions: Establishes the frequency units represented horizontally on an Instrument 
Configuration grid.  
 
Host Name: The unique name that identifies a computer on a network.  

I  

Instrument Configuration: An .sac file containing specific parameter settings that can be 
viewed on other workstations, printed, or emailed.  

L  

Line Marker: Use to activate a solid or dashed horizontal line on an Instrument Configuration. 
You can access Line Markers from the Marker Bar, or Marker Menu.  
 
Load: Trace Menu item used to insert saved trace files on an active Instrument Configuration.  

M  

Marker 1 Vdiff: Tracks and displays a signal buried in noise, or locates a signal under a signal.  
 
Marker 2 Vdiff: Tracks and displays a signal buried in noise, or locates a signal under a signal.  
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Max Hold: Tracks and displays the maximum data value at each frequency. You can gain access 
from the Trace Menu.  

Min Hold: Tracks and displays the minimum data value at each frequency. You can gain access 
from the Trace Menu. 

N  

Normal: A trace type that displays the actual trace value data.  

P  

Point Marker: Use to activate a peak marker on an Instrument Configuration. You can access 
Markers from the Marker Bar or Marker Menu.  
 
Preferences: Menu item accessed from the Tools menu. Used to set Background and Grid 
properties, including color, horizontal and vertical divisions, and units per division.  

R  

RBW: Resolution Bandwidth Filter. A bandwidth dependent filter used to resolve individual 
signals. The narrower the RBW the more noticeable the separation of two signals.  

S  

SA Control Panel: Tampa Microwave’s latest innovation in Spectrum Analysis software.  
 
Span: The width of the frequency range being examined.  

U  

Units Per Division: Establishes the amplitude units represented by each grid cell on an 
Instrument Configuration.  

V  

VBW: Video Bandwidth Filter. Used to reduce or eliminate noise of the signal.  

Vertical Divisions: Establishes the frequency units represented vertically on an Instrument 
Configuration grid. 
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 Open .................................................................      65  
 
P 
  
Parameters Option Buttons ............................     26,27 
PDF User Manual ..........................................     10,70 
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Picture ...............................................................       66 
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Set Threshold ....................................................       63 
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Trace Menu .......................................................      39 
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View Menu .......................................................       66  
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